Hasznalati utmutaté cewe
CEWE FOTOKONYV készitése az Adobe® InDesign® programban

Ez a szolgaltatasunk lehetSvé teszi, hogy CEWE FOTOKONYVET azAdobe® InDesign® programban
készitse el. A CEWE FOTOKONYV sablon-generator megnyitja az On szdmara a megfelel inDesign
sablonokat. A megrendeléshez egyszer(en toltse fel a pdf fajlt az inDesign programbdl. Az alabbi
leirdsban minden fontos informaciét megtalal ahhoz, hogy a megrendelését a legoptimdlisabb mddon
tudja nekiink elkildeni.

Gyors utmutato
Ot 1épés CEWE FOTOKONYVENEK elkészitéséhez az Adobe® InDesign® programban:

Toltse le, és telepitse a Sablon-generator programot. (Elérhet6 Windows és Mac rendszerhez.)
Kérjlik, vegye figyelembe, hogy szlikség van a JAVA legljabb verzidjdra.

Nyissa meg a Sablongeneratort, és végezze el a beallitdsokat. Valasszon boritd tipust, papirt,
méretet és oldalszamot. Ezutan nyissa meg a boritg, illetve a bels6 oldalak fajljat az Adobe®
InDesign®-ban.

Készitse elazoldalakat ésaboritot azAdobe® InDesign®-ban.

Exportalja a boritd és a belsé oldalak pdf fajljait a CEWE FOTOKONYV pdf-exportaléjanak
segitségével. A Sablon-generdtor telepitése utdn ezt megtaldlja az Adobe® InDesign®-ban a
File > Adobe PDF Presets meniiben.

CEWE FOTOKONYVENEK megrendeléséhez az elkésziilt pdf fajlokat toltse fel (boritdt és belss
oldalakat egyarant), és adja meg a sziikséges adatokat.

Altalanos tudnivalék

A CEWE FOTOKONYV Sablongenerétor elkésziti Onnek a megfelel Adobe® InDesign® oldalakat,
tekintettel a gerincvastagsagra és a kifutdkra. A telepitéssel automatikusan a programba keril a
CEWE FOTOKONYV pdf exportalasahoz sziikséges alkalmazas is.

A CEWE FOTOKONYV pdf készlet a megfelels pdf szabvany szerint menti el az On fotokdnyvét (v.
1.3, RGB mdd, bedgyazott betlitipusok)

Javasoljuk, hogy RGB médban dolgozzon, és a képeket is hagyja RGB médban. Onnek nem kell
aggddnia, a kimeneti szinek optimalis konvertalasa a gyartas soran megtorténik.

Kérjik, ne hasznaljon direkt szineket, kiilondsen egyénileg definidlt direkt szineket.

A képek felbontasanak a 300 dpi-t javasoljuk, ennél kisebb felbontads a minéség romlasahoz
vezethet. Legkevesebb 90 dpi, ami még elfogadhatd.

A megfelel6 megjelenités érdekében a grafikus elemek vastagsdga ne legyen kevesebb 0,5
pontnal.

A betliméret digitdlis nyomtatasnal legaldbb 6 pt, fotopapirosnal 8 pt legyen.

Kérjiik, ne helyezzen el vagéjeleket, mert az az elkésziilt CEWE FOTOKONYV-ben latszédni fog.
Minden szikséges vagojel automatikusan hozzaadddik a gyartasi folyamat soran.

A gyartas sordan semmilyen automatikus képoptimalizaciot és élesitést nem alkalmazunk.
Feltételezziik, hogy On, mint tapasztalt fotds vagy grafikus, ezeket a korrekcidkat mar elvégezte.



1. Lépés / Telepités

Toltse le és telepitse a CEWE FOTOKONYV Sablon-generatort. (elérheté Windows és Macintosh
rendszerre)

https://cewe.hu/pdf2book.html?_oss=1
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2. Lépés/ Termék kivalasztasa

Nyissa meg a Sablon-generatort, és pontositsa a CEWE FOTOKONYV bedllitasait.

Egy CEWE FOTOKONYV-hoz két dokumentumot kell Iétrehoznia. Egy tdbboldalas pdf fajlt a belsd
oldalakhoz, és egyet a boritédhoz. A Sablongeneratorban valassza ki a borité fajtajat, a papir
tipusat, a konyv formatumat és az oldalak szamat. Ezutdn a sablonokat egy egérkattintassal
megnyithatja az Adobe® InDesign® programban, igy rogton elkezdheti a szerkesztést. (lasd 3. [épés)
Tamogatott Adobe® InDesign® verzidk: CS4, CS5, CS5.5 CS6, CC.

& CEWE FOTOKONYV Sablon generétor — O X

Fajl Sugé

Kérjiik, valassza ki a kivant CEWE FOTOKONYVET és maris
kezdheti a szerkesztést az Adobe® InDesign® programban.

Boritdtipus Kemény borftd RV
Papiitipus Digitalis nyomtatds N
Formatum XL e
Oldalak szama a0 i

Kényv: CEWE FOTOKONYV XL kemény borités ~ Oldal: 50

Bels oldal sablonok

megnyitasa Borité sablon megnyitasa

Sablon a belsé oldalakhoz

Egy CEWE FOTOKONYV legkevesebb 26 oldalbdl all, melyet a szerkesztés soran négy oldalanként
novelhet. A maximalis oldalszam fligg az album méretétél és a papir tipusatol. Valassza ki egyszerlien
a megfeleld sablont a generatorbdl.

Sablon a boritéhoz

A gerinc szélessége fligg az oldalak szamatdl és a papir tipusatdl. A preciz boritd-sablon
generaldsdhoz adja meg a papir tipusat és az oldalszamot. Amennyiben el6re nem tudja, hogy hany
oldalas lesz a kdnyv, javasoljuk, hogy a boritdsablont csak akkor hozza létre, ha mar az oldalak szama
pontosan meghatarozhaté.


http://www.cewe-fotoservice.de/cewe-fotobuch/cewe-fotobuch-von-pdf-bestellen.html

Termékinformaciok

Valaszthat a ragasztott kotés( digitalis, és a sikban nyil6 fotépapiros CEWE FOTOKONYV kozott. A
két gyartasi technoldgia kozott van par alapvet6 kiilonbség:

Digitalis nyomtatasii CEWE FOTOKONYV (kemény és puha borité, vagy fiizet formatum)

nyomtatas professzionalis nyomdagépekkel

kivalé minGségli ragasztokotés

kemény és puha boritdval is rendelhet6

belsé oldalak: klasszikus matt, magasfényl papir vagy extra matt

papir

Fotépapiros CEWE FOTOKONYV (kemény borité, sikban nyil6 oldalak)

o fotopapirra levilagitott bels6 oldalak

e sikban nyithatd kétés

e  keménytdblas boritd

e  belsé oldalak: matt fotdpapir, fényes fotdpapir vagy extra matt fotdpapir

Minden termék részletes leirasat megtalalja itt:
http://cewe.hu/cewe-fotokonyvek.html

3. lépés / Szerkesztés

A sablonok megnyitasa utan elkezdheti a szerkesztést az Adobe® InDesign® programban (CS4-es
verziotol):
e Barmilyen objektum tipust el lehet helyezni (képek, vektorgrafikak, szoveg). Kérjik, vegye
figyelembe, az 1. oldalon az Altalanos tudnivalékban leirtakat.

e Belsd oldalak: minimum 26 oldalnak kell lennie. Ha tovabbi oldalakat szeretne hozzaadni, azt az
Adobe® InDesign® programban is megteheti. 4 oldalanként bévithet, 34, 42, 50, 58 stb. A
maximalis oldalszam fligg a konyv méretétdl és a papir tipusatol. Ezeket lathatja a
Sablongeneratorban vagy honlapunkon is. http://cewe.hu/cewe-fotokonyvek.html

e A konyv els6 oldala mindig egy szimpla oldal a jobb oldalon, ezutan jonnek a dupla oldalak, majd
a végén ismét egy szimpla a bal oldalon.

e Az Adobe® InDesign® sablonok tartalmaznak egy infé réteget (Info Layer), melyen a vagodjelek,
informacidk és a javasolt szerkesztési tartomany lathaté. Ez a réteg legkésébb a pdf
exportalasanal rejtett lesz. Amennyiben Ont a munka soran ezek zavarjak, igy a Window >
Layers-nél ki tudja kapcsolni. A felette 1évé réteg — Design Layer — Uires, a szerkesztés soran ide
kerlilnek a rétegek. Természetesen tovabbi rétegek is hozzaadhatok.

0 Layers

o > Design Layer

<o A I > Info layer

Page: 1, 2 Layers



http://cewe.hu/cewe-fotokonyvek.html
http://cewe.hu/cewe-fotokonyvek.html

o A belsé oldalakhoz egy 3 mm-es kifutd tartozik. A boritd tipusatél figg6en egy 10-15
mme- es rahagyast tartalmaz, mely a kotészetnél behajtdsra kerdil.
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> Kifuto

A szerkesztési terileten kivili piros terilet a kifutd. Az olyan, teljes oldalt kitolté
elemeknek, mint példaul a hatterek, feltétlen le kell fednitk a kifuto teljes teriletét.

> Vagott méret

A vagott méret a kész termék mérete. A vagas a piros és sziirke terilet taldlkozasanal
van, de a gyartasi technolodgia kovetkeztében ez max. 3 mme-es eltérést mutathat, és igy a
pirossal jelolt kifuto terilletére eshet.

> Szerkesztési teriilet

A sziirke teriilet a biztonsdgi tavolsdg. Annak érdekében, hogy a sz6vegbél vagy grafikai
elemekbdl semmi ne keriiljon levagasra, a fehér szinnel jelolt teriileten belll

szerkesszen.
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> Szinkezelés

A helyes szinmegjelenités alapja a megfelel6 monitor beadllitas. Javasoljuk a gamma értéket 2.2-re, a
szinh6mérsékletet D55-re (5500 K) allitani. Egyszer(i kalibralashoz hasznélhatja a szamitégép bedllitasi
lehet&ségeit, ahol a kontrasztot, vildgossagot stb lehet szabalyozni. Pontosabb kalibraciéhoz sziikséges egy
megvasarolhaté kalibrald eszkoz.

Az optimalis szinvisszaadas érdekében a gyartasban minden kimeneti eszkozhéz és minden papirtipushoz
egyedi ICC profilt alkalmazunk. Kérjiik vegye figyelembe, hogy nem minden, a képernyén lathatd szin
reprodukalhaté a nyomtatdasban. Ezen kiviil masok a digitdlis nyomtatds és a fotdnyomtatas, valamint a
magasfény(i és extra matt papir szinvisszaado tulajdonsagai.

Der Arbeitsfarbraum ist sSRGB, da dieser medienneutral ist. Einerseits stellt er die optimale Ansteuerung fiir
die Fotoprinter und andererseits die Grundlage fiir das Farbmanagement der CMYK-Digitaldrucksysteme
dar. A CEWE FOTOKONYV PDF exportaléja automatikusan biztositja, hogy a dokumentum sRGB szintérben
legyen. Amennyiben a szerkesztés soran mas szintérben dolgozott, ez a PDF exporttal egyszerien
atalakithato.

A fényképezbgépek RGB fajljait minden tovabbi nélkiil hasznalhatja. A gyartas soran ezek a kimeneti
rendszer optimalis szintere szerint konvertalodnak.

4. lépés / PDF exportalasa

Készitse el a borito és a belsé oldalak PDF fajljat.

Ha elkésziilt a szerkesztéssel, exportalja a boritd és a belsd oldalak pdf fajljait a CEWE FOTOKONYV pdf-
exportalojanak segitségével. A Sablon-generator telepitése utan ezt megtaldlja az Adobe® InDesign®-
ban a File > Adobe PDF Presets > CEWE FOTOKONYV opciénal. Kérjiik ne médositsa a beallitasokat! Az
exportald automatikusan a megfelelé PDF dokumentumot hozza létre.

> CEWE FOTOKONYV Adobe PDF preset kivalasztasa

Adobe PDF Presets > Define...

Export... Ctl+E [High Quality Print]..
Publish Online... [PDF/X-1a:2001]...
Publish Online Dashboard... [PDF/X-3:2002]...
Document Presets > [PDF/X-4:2008]...

Document Setup... Ctrl+Alt+P [Press Quality]..
[Smallest File Size]...
CEWE _FOTOKONYV v3.0...

File Info... Ctrl+Alt+Shift+1 [;}
CEWE Ungarn_v3.0...

User...

O | P Rl I N TR o LT o TN =1




> Save as...(Mentés mint)

Expost Adobe FOF

Compatbiey: Ace

a - mincen kbnyvtipusa

(-3

Range:

O Pages

Ezzel elkészigy egyoldalas borités egy toboldalas, belsé oldalakat tartalmazéokumetum
melyet most mar feltélthet. (lasd 5. Iépés)

Ellendrizze a PDF fjjlt.

Az exportalast kovetéen mindkét PDF dokumentumot ellenérizni tudja az Adobe® Acrobat
Professional® vagy az Adobe® Acrobat Reader® programban. Ahhoz, hogy egyszerre két oldal jelenjen
meg egymas mellett, valassza a Nézet > Oldalmegjelenités > Kétoldalas nézet parancsot, majd ahhoz,
hogy az elsé oldal 6nalldan a jobb oldalon latszddjon, és utana kovetkezzenek a dupla oldalak, a Nézet
> Oldalmegjelenités > Borité megjelenitése kétoldalas nézetben elemet.
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Javaslatok a PDF dokumentum ellendrzéséhez:

o  Gy6z6djon meg réla, hogy a boritd és a belsS oldalak egymashoz ill6ek-e. Probléma abban az
esetben fordulhat el6, ha a két sablon generalasanal a termékinformdacidk nem azonosak. A
feltoltés soran torténd gyors ellenérzés jelzi ezt a hibat. (Iasd 5. [épés) A boritdhoz pontosan
meg kell adni az oldalszamot, hogy a gerinc vastagsaga megfeleld legyen.

e Ellenérizze, hogy minden elem megfeleléen helyezkedik-e el.

e Tekintse at, hogy nem maradt-e lres oldal, foté- vagy szovegkeret.



5. lépés / Feltoltés és megrendelés

Amikor elkésziiltek a PDF dokumentumok, a CEWE FOTOKONYV megrendeléséhez keresse fel a
feltoltési oldalt. :

CEWE FOTOKONYV pdf feltoltés

CEWE FOTOKONYYV feltdltése PDF formatumban

+ Borito feltoltése PDF formatumban
+ Belivel felttltése PDF formatumban

Formdtumkévetelmény: PDF /X3 2002

1. Valassza ki a borité és a belsé oldalak PDF fajljait, és kdvesse a monitoron megjelend
utasitdsokat. A feltoltés ideje fligg a fajl méretétdl (MB) és az internetkapcsolat sebességétél.
Amennyiben a felt6ltés és a gyors kontroll sikeres volt, az 6n dokumentuma tovabbitasra keril,
egy nyomtatast megel6z6 részletes ellenbrzésre.

2. Haarendszer mindent megfelel6nek taldl, a megrendelés automatikusan feldolgozasra kerdil. A
rendelési statuszokat érint6 tovabbi informaciokrél hamarosan értesitjik. Ha a rendszer hibat
érzékel a PDF fajlban, egy hibaiizenet fog érkezni a regisztracid soran megadott e-mail cimre. Az
e-mail tartalmazni fogja, hogy milyen manuadlis médositdsokat sziikséges elvégezni a hiba
megsz(intetése érdekében.

Vonalkédok és CEWE FOTOKONYV logé

Annak érdekében, hogy a gyartds sordan a megfeleld boritd keriiljon a konyvtesthez, két vonal kéd kerdil
elhelyezésre. A boritén l1évé vonalkdd helyét a sablon infé-rétegén lathatja.

A belsé oldalakhoz egy tovabbi fehér lap csatolasa torténik, amelyen a sziikséges vonalkdd talalhaté.
Biiszkék vagyunk a CEWE FOTOKONYVRE, ezért minden példanyban a vonalkéd mellett a logénkat is
elhelyezziik.
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https://as.photoprintit.com/web/85004630/views/pdfPhotobookUpload.jsf?windowId=de1
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